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Creative Challenges on PCEC 

Wow, this month marks issue 4 of the newsletter.  Hard to believe it has been 4 months since Christian 

and Jane gave us this outstanding forum and we are about to celebrate 5 months of being up and running 

and learning and sharing together.  I thought I would this opportunity to highlight some of the many great 

challenges that are taking place on the forum right now. 

It seems like there are new challenges popping up every day.  We have a different challenge for almost 

every day of the week.   

Sunday:  Bill‟s Photo Theme 

Monday:  Make Art Mondays 

Tuesday:  Kimi‟s Kreative Homework and Template Tuesdays 

Wednesday:  Anyone have an idea for a new challenge, this is a good day. 

Thursday:  Creative Crop Challenge and Show and Tell 

Friday:  Show off your Creative Imaginations 

Saturday:  Saturday Knight Challenge and Get Tech w/ CS3 

We also have various other challenges that don‟t change each week.  Count to 100 in Photos, 366 Photos, 

12 on 12, Scavenger Hunt Photos, and Caption My Photo.  I originally had Grant‟s Challenge from PET 

listed but instead we say “Farewell” to a great and fun challenge that many of participated in or enjoyed 

viewing what others did. 

All of the challenges have been a lot of fun and great learning experiences.  Keep them coming everyone.  I 

look forward to seeing what our creative members come up with to challenge our talents and creativity.  

As you can see from the above challenge list, there is nothing on Wednesday.  Does anyone have an idea 

for a new weekly challenge?   



Creative Challenge 

This months spotlight challenge is Dane‟s Saturday Knight Challenge.#2 

Doodling (really just another way to sketch) 

 

1. Open your image. 

2. Duplicate the background layer (Right click on the background layer and choose duplicate or CTRL J)) and name that layer Smart Blur. 

3. Go to Filter -> Blur->Smart Blur (I used a Radius 28.2, Threshold 40.3, Quality Low and Mode was set to Edge Only). Just a note, the 

Radius and Threshold setting are not hard and fast, a lot would depend on you picture. 

4. Convert to Black Line on White background (Ctrl I) 

This would be a really good time to remove parts of the picture. Since we are doodling, we want a simple drawing. 

5. Set you background color to white and pick a Hard Round Brush removing parts of the picture 

6. Duplicate this layer three times. 

7. Rename the top layer to Blur 1 (Artistic->Cutout (Number of Levels 5, Edge Simplicity 6, and Edge Fidelity 1)). Filter ->Motion Blur 

(Angle -47 and Distance 150) 

8. Click on the second one (right below Blur 1) and rename that layer to Blur 2 and move it to the top. Repeat step 7. The only change will 

be on the Motion Blur Angle and that will be 47. Next change the Blending Mode to Multiple and lower the Opacity to 54%. 

9. The third layer down, rename to doodle and move to the top. Change the Blending Mode to Multiple and lower the Opacity somewhere 

in the 30-35% range. Now you have a nice sketch and you can stop here if you like. Turn the layer visibility off on the bottom two (click on 

the eye icon on the layer). 

 

This is all you have to do to create what I call doodling. As with most doodling it is done on paper. Remember to have fun.  

 

             BEFORE                                                                                    AFTER 



Interview w/ Rusty, Site Moderator 

                                                                                                                                By JenClark 

Will you tell us a little about yourself? Location/Career/Spouse/Children 

Like many of my generation I went right from university to military service.  I found that I liked what I was doing and intended to stick 

around.  But, what‟s fun for a twenties-something bachelor loses its appeal when you have a wife and two children.  I resigned from the 

Army and had the good fortune of a job with US Steel in NYC and ended up moving to a customer in Milwaukee from where I retired 35 

years later.  I am happily retired now and regret only that one child lives in California and the other in Canada.  I wish it was easier to 

spend time with the four grandchildren. 

 

What was the first thing that made you want to start using a camera? (Special photo, the equipment, or anything that sticks out in your 

mind) 

High school was a boarding school with an excellent photo lab.  I was enthralled by the ability to actually create something and watch a 

print come alive in the developing tray.  First camera was a 35mm Retina Ia – no rangefinder, no light meter.  That was actually good – 

learned real fast how to estimate exposure (good old Sunny Sixteen) and how DOF affects zone focusing.  I lusted for a SLR. 

 

What made you decide to change from film to digital? 

 ike most film guys I couldn‟t imagine that digital was really any good.  My daughter was well into digital by this time so she told her mother 

to give me a camera for Christmas – Olympus P&S, 3MP.  I loved it and would never go back to film. 

 

How did you find your way to Adobe Photoshop Elements/CS? 

My daughter came to Wisconsin to spend Christmas with us that year.  Her now husband gave her a Wacom tablet which was packaged 

with Adobe Photo Deluxe (I think that‟s PSE 1).  She already was using Photoshop so she pulled the CD out of the box, “Here, Dad, you can 

have this and I‟ll show you how to use it.” 

 

What, if any, are your favorite plugins for elements/ CS? 

Neat Image and PTLens; other than those two, I don‟t use many.  I have purchased some stuff from Graffi and Panos which I like and occa-

sionally use. 

 

What books are in your personal library dealing with photography and photoshop? Do you favor one over the other? If so, which one and 

why? 

‟m not a books junkie.  I bought Adobe‟s Classroom in a Book for PSE 3.0 when I finally decided I‟d better figure out how to do more than fix 

red-eye, crop and click smart fix; that‟s what finally opened my eyes to what I could do.  I like Barbara‟s Missing Manual for reference and 

my daughter gave me a wonderful book for Christmas, Digital Nature Photography.  When my wife gave me a dSLR for Christmas, Ken Rock-

well‟s D50 User Guide demystified all the controls and menus. 

 

What is your favorite person/place or thing to photograph? Why? 

No favorite subjects.  I have some places I like: the zoo, two or three parks, one specific area of downtown and, in the summer, of course 

my own yard.  And, year round, my birds and squirrels. 

 

What was the one thing in photography have you had a hard time learning? 

My wife is a very good cook.  She once told our daughter, “If you can read, you can cook!”  I think the mechanics of photography are the 

same: it‟s not that difficult to learn how to take a technically acceptable image and subsequently process it in a wet or digital darkroom.  I 

have been an avid photographer for many years and I‟m still trying to learn how to recognize a great subject.  Even when I am lucky enough 

to see one, effective composition is a real challenge.  I‟m still trying to learn the art, the science part isn‟t that hard.  

 

What does your camera bag consist of? (list all lens, filter, books, even gum wrappers!!) 

No gum wrapper, unless lens paper counts.  Too many lenses: 50mm f/1.8,  28-80mm f/3.3, 18-200mm f/3.5, 70-300mm f/4 (Macro 1:2).  An 

assortment of filters: ND and polarizers.  A cheap tripod and an expensive ball head.  Blower brush and Rocket blower.  I do not try to lug 

all this around all the time. 

 

What is the next thing on your must have list? 

Naturally, another lens.  I really, really, really want a nice super wide-angle zoom – something that starts around 10mm or 12mm. 

 

What is your favorite photo and why? Was this a planned capture or a chance shot? (Please include the photo) 

Probably the last one I took.  I have a few really good planned shots; most are happy accidents.  I sometimes plan something and then real-

ize that something I never even thought about is in there. 



How much time would you say you average on photography each week? 

Actual photography: two or three hours in the winter; many more when the weather is nice.  Playing on the computer: two or three or 

more hours a day.  My wife calls it my cave. 

 

What are your hobbies/interest (including the obvious, photography) and in what order would you place them in from favorite to least fa-

vorite? 

Woodworking has been a hobby for almost as long as photography.  Before I discovered the digital darkroom, it was clearly my primary 

relaxation interest.  Now it is way back in 3d place.  This forum is in solid 2d place.  I put it as an overlap between “photography” and 

“social activity with friends”.  In addition to asking questions, getting and giving help, we seem to manage to have fun as well.  That‟s a good 

thing. 

 

 



Making a Panorama by Rusty 

Panoramas are not difficult to make and, without a super-wide-angle lens, are sometimes the only way to do justice to a subject.  There‟s 

nothing artistic about these examples, they were taken from the stoop outside my front door on a cold February day.  Unless you have a 

compelling image, it will be more fun to wait for a pleasant Spring day. 

 

First: take your camera off of Auto.  Auto Exposure and Auto White Balance will introduce exposure variations that make it difficult to 

stitch the images together.  This is what Auto does for you. 

These are five images covering a 170-degree field of view.  Auto exposure produces, left to right, 1/400th@f/10 (twice), 1/320th@f/9, 

1/250th@f/8 and 1/320th@f/9.  I have no idea where Nikon came up with 1/250th@f/8 in the center because it blows the snow out to such 

an extent, I don‟t think anything can be done with this. 

 

Set WB on something; it will then be consistent for every single shot; I set on “daylight”.  Switch exposure to manual and expose for the 

highlights. 

Ooops – I went the absolutely wrong direction.  Only the center is anywhere close to the correct exposure; everything else is way overex-

posed.  To expose for highlights, this is the way I did it when I got my brain in gear.  Decide what shutter speed you want and set camera 

on shutter priority – I figured 1/250th was as good as any.  Pan thru what you are going to shoot, watch what apertures are selected at vari-

ous parts of what is going to be the panorama image.  They are all at 1/250th so watch for the highest f-stop … that‟s where the highlights 

are.  I saw that f/14 was the smallest aperture I could see.  Now, switch to manual exposure and get your camera set on 1/250 th at f/14. 

 

Don‟t think all panoramas have to be horizontal pans.  Most are but it is just as easy to use this to cover a vertical 

 

Here is another trick.  Take the shots in portrait orientation.  You will have to stitch more images together, I ended up with 9 rather than 

5, but you have a lot more to work with as far as cropping is concerned.  This is what I got when properly exposed:  



The arrows show where some clone stamp work is required but it‟s pretty darned close so cloning to smooth out the transitions will be 

easy and fast. 

 

All of the above were shot with a 50mm lens and the camera was on a tripod.  Do you have to have fancy equipment?  NO … it makes it 

easier but is not required. Here is what I got handholding a P&S: 

 

 

Because of the short focal length, I only needed four images to cover the area.  Some clone stamp work is required on transit ions.  I will 

admit, I had advantages that may not be present on all P&S cameras.  My Nikon Coolpix has a menu setting for panorama.  The only option 

I have is Auto but, whatever exposure and WB is selected for the first shot is locked and repeats for all subsequent exposures.  This turned 

out to be about 1/750th at f/4.8 with ISO at 50. 

 

There are various ways to stitch the images together.  I was using PSE 5‟s built in Photomerge which is pretty good.  PSE 6 has a similar fea-

ture which I understand is much better.  When I used PSE 3 I did it the hard way.  Open a blank file, wide and skinny, and drag your images 

onto the file.  Move them around until they match up. 

 

 

One last thought.  If you use one of the canned Elements routines, after about half way through the procedure you see an option for how 

the image is treated.  With PSE 5 it‟s over on the lower right side.  The default is to merge everything into one layer.  Uncheck that and tell 

Elements to preserve the layers.  After everything is finished, zoom in to look at the edges where the individual images were joined.  As 

good as Elements is, it isn‟t always perfect.  If necessary, use the move tool to tweak the position of one or more layers.  Don‟t try to move 

it with the curser, use the arrows – much more precise.  Preserving the layers makes for a huge PSD file.  After you have finished fine tun-

ing, you can flatten the image if size is a concern. 

 

Now, make a panorama.  As I said, it‟s fun.  Find a better, more interesting subject than my illustration.  Here is my final product, if you don 

have a great subject, jazz up the presentation 

 

 

 

 

 

 

 

If you have problems or questions when you try this, post your question.  Somebody will jump in to help. 



Q & A 

Q:  Kev makes reference to the use of PSP Tubes.  What are they?  How do we use them?  What do we need to get 

them?  What he does is intriguing.  I hope with PSE4 I can make use of them.                                                                    By 

quilabee                                                                                                                            

A:  Using PSP Tubes To Make Tiles.   By Kev 

If you have downloaded the 2020 program this should help you to make even better papers. It uses a plug in that allows you to use PSP 

tubes in Elements.  The Plug in is available from- 

  

http://www.telegraphics.com.au/sw/ 

  

Look for- Paint Shop Pro Format. 

The first thing we have to do is put the plug in the correct folder. 

If, using Explorer you go to your Plug In folder you will see a folder called File Format, as shown. 

  

 

 

 

 

  

 

 

 

 

 

 

 

Put the Plug in to this folder. Need I say that Elements must be closed while you do this? 

  

Now we are ready to start to make great papers. 

  

Make a new folder, on your desktop called psp tubes and another called pngs. Believe me when you get going they are going to be needed. 

Now do a Google search for PSP tubes. There are hundreds if not thousands of sites. 

Select a tube, save as to your tubes folder. They will be either in JPG or one that looks like this. 

 

 

 

  

        

The main thing is that they have either TUB or psp in their name. 

  

Now for the interesting bit, 

Start Elements, Control O to open and find your tube in the folder, open it. You will not see a preview but just open it. 

You should see something like this this,  

 

 

 

 

 

 

 

 

 

 

It will look like a PNG image on a transparent Background but it‟s still a PSP file. 

Save as a png file to your png folder.  

Close the psp file and then open the png file. As you can see from the following screen shot it‟s very small. 



   

 

 

 

 

 

 

 

 

 

 

 

 

 

 

We will now fix that. 

  

If you hold Control and click on the new layer icon you will get a new layer below the one shown. 

With the new layer selected, Go To – Image – Resize – Canvas Size. Make sure that relative is ticked and add the same number in height 

and width. 

In this example I added 1 inch to both. Then pick a color of your choice, 

With the bottom layer selected Alt + Backspace to fill with the color. 

  

 

 

 

 

 

 

 

  

 

 

 

 

 

Save this as a JPG file. 

You are now ready to use 2020 to create your seamless tile, you may want to increase the sizes used in the increase canvas size but it is all 

a question of trial and error. Only you will know when you‟re happy with the final results. 

  

Here is a screen shot of the paper created. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  

 

  

If you make sure this is not a background layer when you open it ( hold Alt and double click on the thumbnail in the layers palette) you can 

drag out the sides to your own taste and then resave. 

Hope you can understand this try at a tut. 



  

 

Making A Seamless Tile And Paper With 2020 

By Kev 

 

If you haven‟t already downloaded 20/20 you can do so HERE for free. 

When you open 2020 all you see is this. 

 

 

 

 

 

 

 

 

If you click on the button indicated by the red arrow you will be able to pick the image (jpg) you wish to tile. 

When you open your image you will see this 

  

 

 

 

 

 

 

 

 

 

 

 

 

 

  

The arrow is pointing at Image. Clicking here allows you to Resize, I like to resize my images to 3 inches on the longest side but it is up to 

you.  Click on Image - Seamless tile.  You have created your tile.  Go to File - Save As, save as a JPG. 

 

Now you have to create the paper 

This is very easy. 

Open Elements, find your tile and open it. 

Go to Edit - Define Pattern. Click OK. 

You can now close the image we don‟t need it any more. 

Control N to open a new page. I normally use 10 x 8 inches at 72 resolution. This tends to make the pattern larger. However the choice is 

yours. When your page is open, Control+A to select all. 

Go to Edit - Fill Selection. Select Pattern and the last one should be your tile. Click OK and the page will fill with your tile. 

You have made a background paper. Now you can save it as a JPG, you can resize it  or do with it what you will. 

I would suggest that you start with simple images at first and get more daring after a little practice. 

The end results can be very beautiful. 
 

http://download.chip.eu/en/20_20-2.2.7_73414.html


Christell‟s Color Sketch Technique 

 

Open photo. 

Copy background layer. (CTRL. J) 

Set Black as foreground color & white as background color. 

Go to Filter>Sketch>Photocopy. 

    Set detail:23 

    Set darkness:47 

Go to Filter>Adjustment>Threshold. 

Move slider to right to darken; Between (160-255). OK. 

Invert (CTRL. I) 

Set Blend mode to Overlay for more color & detail. 

Set Blend mode to Soft Light for a more softer look. 

Adjust the opacity on this layer. 

Set opacity 25-50% to give a smoother look. 

Set opacity 60-100% to give it a more color, dimension & texture. 

 

To go a step further try playing with other filters to see how they  

affect the photo. 

For example: 

Filter>Artistic>Cutout. 

Go down & try each one to see the change. 

 

Christell 

 

I played around with  this technique after  participating in Be  

Creative Week at the Village using Photocopy filter. 

 



Edges and Contours for Sketching by MichelB 

Edges and contours are a very wide topic in digital photography editing. Sharpening is certainly the first concern... Over sharpening and ha-

los, edge artifacts are also a common problem for edges. And for creative people, achieving sketch or painterly effects is also based on edge 

control. 

 

What are edges and contours in digital imaging? Visually, edges are the boundaries between two areas. Your software analyses each pixel 

values, and compares them with the values of surrounding pixels (tone and color as expressed by R,G,B values). Edges are shown by sharp 

differences in adjacent pixels values. Sketching is like drawing a line on the boundaries. How can a digital software based on values, do the 

math, first to find edges, second, to draw the line? 

 

Sorting tools: 

Many of the available tools deal with edges. We'll have a look at a list of common editing affecting edges. Then we'll find which are specifi-

cally meant to find and show edges (high pass), and those who are supposed to do the job directly (find edges and trace contours). What 

may be interesting is that unexpected tools, the purpose of which is not to sketch, are very convenient to draw... smart blur for example. 

Anyway, whatever the tool you choose, you'll want to enhance the result, simplify, change it with other tools like threshold, levels, gradi-

ents. Or with a lot of artistic or stylize tools like emboss, ink outlines, poster edges, which have an effect on edges.  And finally, you'll dis-

cover how you can draw with much simpler tools like sharpen, blur or move, using layers in difference mode, or stroking a selection.  

What can we do with edges? 

We are working on edges when we: 

sharpen (make the difference higher and closer the edge. If the transition is spread over 10 pixels, make it happen in 1 or 2 pixels...) 

blur (the inverse process) 

reduce halos and artifacts along edges (de-noising software) 

create edge masks to hide or show edges for de-noising without blurring or sharpening without increasing noise in flat areas 

define selections based on difference in tone or color between adjacent areas 

work with selections by feathering trace contours 

create special effects, emboss, photocopy, ink outlines, poster edges reveal texture for overlays... 

 

The tools in Elements: 

What are the main available tools to deal with edges in Elements and how can you use them for sketching or painterly effects? If a tool is 

based on edge detection, there is a way to use it for sketching. You can find a dozen of ways to sketch.  

Edge detection: high pass. 

The high pass filter is the tool to detect and show edge variations. It's really a filter by the fact it filters, i.e. lets high frequency changes pass 

through (= changes between very close pixels) and ignores larger scale changes. Visually, it makes the high frequency transition more con-

trasty and leaves medium and low frequency shown in neutral gray. Let's say you have an edge between a clear grey area and a darker one. 

The filter shows the light grey going lighter as it approaches the dark one, and vice versa. The edges are shown by a double line, clear and 

dark. This property is used in the high pass sharpening method. Using duplicate layer in soft light or overlay mode, the high pass filter will 

make edges more contrasty, visually sharper. 

 

A side remark: if you invert this high pass layer (Ctrl I), edges become less sharp... That's exactly what the Gaussian blur does.  

The result is not very contrasty, so you'll need to increase it to get a sketch effect. You can use threshold, levels, gradients... to mask the 

gray and enhance the contours.  

Specialized filters: 

In the Stylize menu, you find two dedicated tools. 

find edges 

trace contours 

They can give you an immediate sketching effect. However, you should never be satisfied with the first try: they are excellent starting points 

for drawing, provided you enhance them with other tools like threshold, levels, gradients, blur, diffuse... And if a setting is good to extract 

the texture of part of an image, there are other parts which may need a different setting. So you'll have to extract and combine different 

layers by masking.  

Smart blur: 

There is one favorite filter called smart filter. Its name is as misleading as that of unsharp mask. Yes, it can blur, but it can also reveal edges 



in a very particular way. If you select 'edge only' at the bottom of the dialog, only edges are shown in white over a black background. Find-

ing the best settings for the sliders is not easy, but many love this filter as a starting point (you'll have to invert the result to get a positive 

drawing). 

 

Artistic filters: 

This category includes several filters who are partly based on edge detection: 

emboss 

photocopy 

poster edges 

glowing edges 

etc. 

They are not the best ones to create sketch effects, but they can be used to change and enhance other sketching methods. Don't forget 

you can play with the hardness/softness by blurring, diffusing, and alter line sketch width with maximum/minimum. 

 

Simple tools based on difference mode. 

You can sketch and obtain very similar results to find edges or trace contours with much simpler tools by using layers and the blend mode 

in difference. This blend mode makes different pixels lighter and leaves unchanged pixels black. They may help you understand better how 

specific tools can work. 

 

Move tool.                                                                                                                                                                                         

Duplicate layer in difference mode; move the duplicate one pixel up and one right: The contours appear. 

Any blur or sharpen tool on a difference mode duplicate: same thing, or minimum, maximum or even custom filters in the duplicate, same 

result.  Working with the difference between a sharper and less sharp layer is based on the same principle as high pass or specific filters. It's 

the principle of USM, unsharp mask, which mimics the old darkroom technique of sandwiching a slightly out of focus positive to enhance 

edges.   The result of a layer in difference mode is very dark: black where there is no difference and lighter and lighter as the difference 

grows. To get a usable result, you'll have to use a threshold, levels or gradient map adjustment layer and invert the result. 

 

Selections and stroke: 

You have selected a shape: save selection. Create new blank layer, recall selection and stroke. You'll get your contour on a blank layer. 

Combining tools 

If you play with the different above mentioned tools, you'll find many show edges, but are not able to be used as a sketch. In many cases, 

you'll have to invert, increase contrast, use threshold, levels, gradients... to get a good contrast. 

First thing is often to have de-noised the image first. Then mixing two different methods may give good results. Softening the contours may 

be obtained by Stylize/diffuse (anisotropic) or motion blur... and many other ways.  

You'll notice many of these tools can be tuned to detect edges, and by doing so, you get a better effect on a part of the image, but lose the 

effect on other parts... then create two different layers to be combined later, to keep detail in all parts of the image. 

 

And now, it's up to you to play and find YOUR sketching method!  

 

My steps for this image from the Julie‟s Creative Imaginations Challenge are: 

- equalize 

- find edges 

- remove color 

- select sky and delete  

 

 



Color Management Part 4 by Colin aka Codebreaker 

Printer Settings (Photoshop Elements managing the colours) 

 

Since there are a huge number of different printer makes in use it‟s not possible to provide specific details for each one.  In this section 

we‟ll just look at three printers and this may help you identify similar settings in your Printer Driver.  I‟ll also assume you can find your way 

into the Printer Driver.  The assumption here is that we are going to let Photoshop Elements manage the colours so we need to set the 

Printer Driver NOT to manage the colours.  You must never let Elements and the Printer manage the colours  

 

We‟re going to look at :- 

 

Epson R2400 

Canon i850 

Canon ip4500 

 

 

 

Epson R2400 

 

When you open the Printer Drive it starts by showing only the basic settings and you need to click on the Advanced button to get to the 

options needed for controlling Colour Management. 



 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

The Advanced window now shows controls for Colour.  You will see a checkbox called ICM, typically if you check this box then you are 

instructing the Printer Driver to manage the colours.  However, in the case of the Epson R2400 this is only partially true.  To actually turn 

OFF colour management in this printer the ICM checkbox needs checking, which then gives even more options, as shown below. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Now you see another set of options and the one we‟re interested in is the „Off (No Colour Adjustment) checkbox.  Checking this will ac-

tually turn off the Printer Driver colour management. 



 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

The final thing to remember is to always select the appropriate paper type in the Paper and Quality Options dialog. 

 

Canon i850 

 

For the Canon i850 life is a little easier.  This is the first dialog window from which you need to select the Manual Colour Adjustment op-

tion and then click on Set.  Then the ICM checkbox can be cleared for No Colour Management in the Printer Driver. 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Canon IP4500 

 

This is the first Dialog window from which you need to select the Manual Colour/Intensity option and then click on Set.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



In the Colour Correction options choose None.  This stops the Printer Driver from managing the colours.  Leave all the other settings as 

they are. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

ummary 

 

You should choose an option under Edit > Colour Settings that allows the Colour Profile of the source image to be used and my 

recommendation is to choose Always Optimise Colours for  Computer Screens.  Learn what these settings really mean to your 

images to help you decide if you can use one of the other options. 

 

Convert your image Colour Space only if you are confident in what you are doing. 

 

Decide where the Printer Colour Management is to be performed – Elements or the Printer Driver.  The recommendation would 

be to let Elements do this, never both. 

 

Select a Print Space that either:- 

 

o Lets the Printer Driver do the Colour Management – „Printer Colour Management‟ 

 

o Uses the specific profile that matches your printer and paper. – „Elements manages the colours‟ (recommended) 

 

Choose a Rendering Intent of Relative Colourimetric.   However, since images are very subjective you might also try Perceptual – 

what ever works for you.  The other two are not recommended. 

 

Enable or Disable the Colour Management in your Printer Driver as appropriate.  Look for an option that controls ICM, (and 

NCA – No Colour Adjustment in Epson printers). 

 

Lastly start your printing experience by using the printer manufacturers own papers and inks.  Once you‟ve baselined the results 

you can try other types – but see if you can find a Profile for the paper you are going to use. 

 

Finally if you‟ve lasted this long, well done. 
 

 



St. Patrick‟s Kit by Smiles 

Click HERE to download 

http://www.4shared.com/file/39346589/ab5cbbb0/Shari_St_Pat_Kit.html


St. Patrick‟s Paper and QP by JenClark 

Click
 

HERE 

To 

Download 

http://www.4shared.com/file/39345140/6b894b2a/scrap_IBJC.html


Bunny Kit by LadyBug 

Click 

HERE 

To 

Download 

http://www.4shared.com/file/39339550/8d6db11f/Judys_bunny_kit.html


Star Mini Kit by Ladybug 

Click HERE to download 

http://www.4shared.com/file/39339998/26198f45/star_kit_by_jaw.html


Spring Kit by AP_Photos 

Click 

HERE 

To 

Download 

http://www.4shared.com/file/39338832/855d8383/Amanda_Spring_Kit.html


Hall of Fame Images of the Month 

1st Place 

By Kev  *  Blanc  *  A Sketch Method 

2nd Place 

Precious Hands by AngelicKim 

3rd Place 

Cat Sketch by Hukari 

http://www.photoshopcreativeelements.com/viewtopic.php?f=18&t=2058


Tropical Kit Embellishments Preview 



Tropical Kit Papers Preview 

 



Tropical Kit Papers and Alpha‟s Preview 

 



Tropical Kit Frames Preview 

 

Missing from these previews are the Word Art files 

Thanks to all who contributed your hard work and Creativity 

 

Jane 

Denise 

Michelle 

Kim 

Amanda 

Reka 

Suzi 

Judy 

 

Gail 

Gary 

Sunny 

Shari 

Andie 

Susan 

Jen 

Great Job everyone!!!! 

 



Hall of Fame Nominations 


